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Abstract: Blood pressure is a critical physiological parameter used to evaluate cardiovascular health.
Traditional cuff-based methods provide accurate measurements but are not suitable for continuous
monitoring. This paper proposes a deep learning-based approach for predicting blood pressure using
Electrocardiogram (ECG) signals. ECG and arterial blood pressure (ABP) signals are obtained from the
VitalDB dataset and preprocessed to remove noise and missing values. A hybrid model combining
Convolutional Neural Networks (CNN) and Bidirectional Long Short-Term Memory (BiLSTM) is used to
extract spatial and temporal features. The model predicts systolic blood pressure (SBP) and diastolic
blood pressure (DBP) and classifies them into low, normal, and high categories. Performance is
evaluated using MAE, RMSE, and R? score. Results show that the proposed model effectively estimates
blood pressure, enabling non-invasive continuous monitoring.
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I. INTRODUCTION
Blood pressure is an essential indicator of cardiovascular health. Abnormal levels may lead to serious conditions such
as heart attack, stroke, and kidney failure. Conventional cuff-based methods provide only periodic readings and are
unsuitable for continuous monitoring. Therefore, there is a need for non-invasive and continuous monitoring systems.
Electrocardiogram (ECG) signals contain valuable information about heart activity. With advancements in deep
learning, ECG signals can be used to predict physiological parameters like blood pressure. This paper presents a hybrid
CNN-BiLSTM model to estimate systolic and diastolic blood pressure from ECG signals.

II. LITERATURE SURVEY
In[1] Derya Kandaz (2025) proposed a model for continuous blood pressure estimation using electrocardiography
(ECG) signals. The study utilized ECG datasets from PhysioNet and MIMIC and demonstrated that accurate and
continuous blood pressure estimation can be achieved using non-invasive ECG signals. In[2] Toth et al. (2025)
investigated the finetuning and quantization of EEG biosignal models for ECG and PPG data in blood pressure
estimation. Using the MIMIC-III dataset, their work improved systolic and diastolic blood pressure prediction by
adapting pre-trained biosignal models. In[3] Sanches et al. (2024) introduced the MIMIC-BP dataset, a curated dataset
designed specifically for blood pressure estimation research. The dataset includes ECG, PPG, and ABP signals from
MIMIC-III and provides standardized and cleaned data to improve research reliability. In[4] Jeong and Lim (2024)
proposed a Conv-LSTM based deep learning model for continuous blood pressure prediction using ECG and PPG
signals. Their results showed that the Conv-LSTM architecture effectively captures temporal dependencies in
physiological signals for accurate blood pressure prediction. In[5] Wang et al. (2023) presented a large cleaned dataset
for cuffless blood pressure estimation using ECG and ABP signals. Their research showed that deep learning models
outperform traditional machine learning techniques in predicting blood pressure. In[6] Slapnicar et al. (2019) proposed
a deep learning approach using convolutional neural networks (CNN) for blood pressure estimation from ECG signals.
Their results demonstrated that CNN models can directly learn relevant features from ECG signals and accurately
predict blood pressure values. In[7] Kachuee et al. (2017) introduced cuffless blood pressure estimation algorithms
based on ECG signal features. Their work demonstrated the feasibility of predicting blood pressure without traditional
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cuff-based devices using machine learning models. In[8] Panwar et al. (2020) explored machine learning techniques for
blood pressure estimation using ECG signals. Algorithms such as Random Forest and Support Vector Regression were
applied, achieving reasonable accuracy in predicting blood pressure.

In[9] Hasanzadeh et al. (2020) proposed a non-invasive blood pressure estimation approach using ECG morphology-
based features. Their study showed that ECG waveform characteristics contain useful information for estimating blood
pressure. In[10] Mousavi et al. (2020) developed a hybrid deep learning model combining CNN and LSTM networks
for blood pressure estimation using ECG and PPG signals. The combination of spatial and temporal feature extraction
improved prediction performance.

III. METHODOLOGY
The proposed methodology aims to develop a deep learning-based system for estimating blood pressure using
electrocardiogram (ECG) signals. The overall workflow of the proposed system includes dataset collection, signal
preprocessing, segmentation, model training, and performance evaluation. The block diagram of the proposed
methodology illustrates the complete process involved in predicting systolic blood pressure (SBP) and diastolic blood
pressure (DBP) using ECG signals.

IV. PROPOSED SYSTEM ARCHITECTURE
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MODEL DESCRIPTION:

The proposed system for blood pressure prediction using ECG signals is divided into several modules. Each module
performs a specific task in processing the physiological signals and generating accurate blood pressure predictions. The
modules include dataset collection, signal preprocessing, signal segmentation, deep learning model development, blood
pressure prediction and classification, and performance evaluation.
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1. Dataset collection module:

Description

This module is responsible for collecting physiological signal data required for the proposed system. The ECG and
ABP signals are obtained from the VitalDB dataset, which contains real clinical monitoring data recorded from
patients. These signals provide the necessary information for predicting systolic and diastolic blood pressure values.

Features

* Provides real-world biomedical signal data

* Contains ECG and ABP waveforms for cardiovascular analysis
* Enables non-invasive blood pressure prediction research

* Supports large-scale data analysis

Implementation

The ECG and ABP signals are extracted from the VitalDB dataset using appropriate data processing tools. The
extracted signals are stored in a suitable format such as CSV or NumPy arrays for further processing in the next
modules.

2 .Signal Preprocessing module:

Description

The extracted signals may contain noise, artifacts, or missing values that can affect the accuracy of the prediction
model. Therefore, preprocessing is performed to clean and prepare the signals before training the model.

Features

* Removal of noise and corrupted signal values

» Handling missing or invalid data points

* Normalization of signal values for model training
* Alignment of ECG and ABP signals

Implementation

* Preprocessing includes removing NaN values

» Filtering noise from signals(values).

* Applying normalization techniques such as Min-Max scaling.

MinMaxScaler Formula:

X — X’.rn-in
X s X’J"ﬂ‘i?’t

X; sealed —

Where:

* X = Original value

* Xmin = Minimum value in the dataset

* Xmax = Maximum value in the dataset

* Xscaled = Normalized value between 0 and 1
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3. Signal Segmentation module:

Description

Continuous ECG signals are divided into smaller fixed-length segments. Segmentation helps the model capture
meaningful patterns in the ECG waveform and improves training efficiency.

Features

* Converts long signals into manageable segments

* Captures temporal patterns within short time windows
* Improves training efficiency and model performance

Implementation
* The ECG signal is divided into fixed time windows (10-second segments).
* Each segment is treated as an individual data sample that will be used as input to the deep learning model.
* After segmentation, the dataset becomes:
Total segments : 642
Segment shape : (1250,)

4 Deep Learning Model (CNN + BiLSTM) module:

Description

This module involves the development and training of a deep learning model for predicting blood pressure from ECG
signals. The proposed architecture combines Convolutional Neural Networks (CNN) and Bidirectional Long Short-
Term Memory (BiLSTM) networks.

Features

* CNN extracts important spatial features from ECG signals.

* BiLSTM captures temporal dependencies in sequential data

* Hybrid architecture improves prediction accuracy.

* Learns complex relationships between ECG signals and blood pressure

Implementation

* The segmented ECG signals are used as input to the CNN layers.which extract relevant features from the waveform.
* These features are then passed to the BiLSTM layer to analyze temporal patterns.

* Finally, fully connected layers generate the predicted SBP and DBP values.
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Deep Learning Model Architecture (CNN + Bi LSTM)
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Architecture Explanation:

a) Input Layer

* The input to the model is an ECG signal segment containing 1250 samples.

* These samples represent a short time window of the ECG waveform used for feature extraction.

b) First Convolution Layer (ConvlD — 64 Filters)

* The first Conv1D layer applies 64 filters to the ECG signal to extract important low-level features such as waveform
patterns and signal variations.

* CNN helps in automatically learning meaningful features from the raw ECG signal.

¢) MaxPooling Layer
» The MaxPooling1D layer reduces the dimensionality of the extracted features by selecting the most important values.
* Pool size used: 2.

d) Second Convolution Layer (Conv1lD — 128 Filters)
* The second Conv1D layer uses 128 filters to extract deeper and more complex features from the ECG signal.
* This helps the model learn more detailed physiological patterns related to blood pressure.

e) Second MaxPooling Layer
» Another MaxPooling layer is applied to further reduce the feature size and retain the most relevant information.
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f) Bidirectional LSTM Layer (Units = 64)

» The Bidirectional LSTM layer processes the ECG sequence in both forward and backward directions. Number of
units used: 64 .

Advantages:

* Captures temporal dependencies in ECG signals.

* Improves sequence understanding.

* Enhances prediction accuracy.

g) Dense Layer (64 Units)
» The Dense layer acts as a fully connected layer that combines the features extracted from CNN and BiLSTM layers.
« It helps the model learn the relationship between ECG features and blood pressure values.

h) Dropout Layer (Rate = 0.3)

* The Dropout layer randomly disables 30% of neurons during training.
Purpose:

* Prevents overfitting.

* Improves model generalization.

i) Output Layer

* The final Dense layer with 2 neurons predicts,
* SBP (Systolic Blood Pressure).

» DBP (Diastolic Blood Pressure)

5. Blood Pressure Prediction and Classification:

Description

After training the model, it predicts systolic blood pressure (SBP) and diastolic blood pressure (DBP) values from the
ECG signal segments. The predicted values are further categorized into blood pressure levels.

Features

* Predicts SBP and DBP values.

* Enables non-invasive blood pressure monitoring.
» Categorizes results into health condition levels

Implementation
* The trained model generates SBP and DBP predictions for the input ECG signal values.

Category SBP DEP
Low BP =90 =60
Normal BP 90-120 60-80
High BP =120 =80

BP Classification Table
» The predicted systolic and diastolic blood pressure values are categorized into three levels: low, normal, and high
blood pressure.
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» These classification thresholds help in identifying the health condition of the patient and provide a simple
interpretation of the predicted blood pressure values.

6. Performance Evaluation:
Description
This module evaluates the performance and accuracy of the proposed blood pressure prediction system.

Features

* Measures prediction accuracy.

» Compares predicted and actual blood pressure values.
* Provides statistical evaluation of the model

Implementation

Evaluation metrics such as Mean Absolute Error (MAE), Root Mean Square Error (RMSE), and R? score are used to
measure model performance. These metrics help determine the reliability and effectiveness of the proposed deep
learning model.

1. Mean Absolute Error (MAE)
MAE measures the average absolute difference between the actual and predicted values.
Formula :

T, e
MAE = =3 |y: —
n{1’y i

Where :

* yi = Actual value,

* yi* = Predicted value,

* n = Total number of samples.

2. Root Mean Squared Error (RMSE)
RMSE is the square root of the Mean Squared Error, which represents the prediction error in the same unit as the target

variable.
Formula:

1 —

RMSE = \ » > (yi — 4i)?
T =
1=1

3. R-Squared Score (R?)
R? measures how well the model explains the variance in the data.
Formula :
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* yi* = Predicted value,

*y =Mean of actual .

1. Model Prediction output
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2. GRAPHS:
* Actual vs Predicted graph of SBP
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3.Blood Pressure Classification Results

4. Performance Measures Results:

5. Model summary:

Model: "sequential™

10 20 30 40 50
Sample

Low BPF count: &
Mormal BP count: &
High BP count: 73

===== SBP RESULTS =====
MAE : 14.38217@571615532
RMSE : 17.76681138826414
R2Z : B.B854748656387831081

===== DBP RESULTS =====
MAE : 5.983696359442186
RMSE : 7.848352187923553
R2 : 8.114547533@2361537

Layer (type) output Shape Param #
convid (ConviD) (None, 1248, 64) 256
max_poolingld (MaxPoolinglD) (None, 624, 64) <]
convid_1 (ConviD) (None, 622, 128) 24,704
max_poolingld_1 (MaxPoolinglD) (None, 311, 128) -]
bidirectional (Bidirectional) 128) 98,816
dense (Dense} (None, 64} 8,256
dropout (Dropout) (None, 64} <]
dense_1 {Dense} {None, 2) 130

Total params: 132,162 (516.26 KB)

Trainable params: 132,162 (516.26 KB)

Non-trainable params:
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V. EXPERIMENTAL RESULT AND ANALYSIS
* The performance of the proposed CNN-BiLSTM model for blood pressure prediction was evaluated using the
VitalDB dataset.
» The ECG signals were used as input to the model, while systolic blood pressure (SBP) and diastolic blood pressure
(DBP) values derived from the ABP signal were used as target outputs.
» The dataset was preprocessed and segmented into fixed-length windows before training the model. The dataset was
divided into training and testing sets to evaluate the prediction performance.
* The trained model was tested on unseen ECG signal segments to predict SBP and DBP values.
* The performance of the model was measured using standard evaluation metrics such as Mean Absolute Error (MAE),
Root Mean Square Error (RMSE), and the coefficient of determination (R? score).

SBP Prediction DBP Prediction
MAE 14.15 mmHg 5.90 mmHg
RMSE | 17.56 mmHg 7.84 mmHg
R? 0.05 0.11

VI. CONCLUSION
This study presents a deep learning-based approach for predicting blood pressure using ECG signals. The hybrid CNN-
BIiLSTM model successfully extracts features and predicts SBP and DBP values. The results show that ECG-based
prediction is a promising alternative to traditional methods. Future work can focus on improving accuracy using multi-
signal data and advanced models.
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